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Welcome to the Visibility for Vaccines (ViVa) user guide! ViVa is a web-based tool that enables users to monitor their vaccine stock levels and
project future stock levels based on upcoming deliveries. The tool was developed by UNICEF and WHO to help EPI managers anticipate future
stock-outs or overstocking, and take corrective action in time.

This user guide will provide an overview of the features and interface of the ViVa web tool. For additional support, please contact your UNICEF
focal point, or e-mail viva@unicef.org.
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1. Introduction to ViVa

1. An
advocacy tool
to enable

The Visibility for Vaccines (Viva) platform is a vaccine stock monitoring visualization tool that funding
allows the user to view vaccine stock level projections at national and regional stores, and quickly TS
identify and anticipate potential stock issues. The tool is intended to be used by Expanded
Programme Immunization (EPl) managers, national vaccine supply and logistics managers, and
other counterparts in the Ministries of Health, to monitor and take proactive action against stock-
outs, overstocking, or other supply-related issues.

ViVa is intended to be used in addition to existing tools, such as the Stock Monitoring Tool (SMT),
to enable Government counterparts to enable a comprehensive view of their stock inventory
position and identify potential issues.

2. A vaccine stock
visualization tool
showing orders from

unicef &

a. Whatis Viva?

ViVa provides a snapshot of the EPI vaccine stock inventory and projects stock levels in time. What
can you do with it?

e Get a snapshot of a country’s current stock situation at a glance, including national and regional locations
e See a projection of a country’s stock situation in the future, including upcoming confirmed deliveries from UNICEF
e Anticipate when stocks will run out, and take corrective action if necessary

e Export PDF files and PowerPoint presentations of these charts for greater advocacy and communication with partners and stakeholders

ViVa is based on multiple sources of information from country stock inputs and UNICEF Supply Division (SD): annual vaccine consumption; confirmed
vaccine deliveries from UNICEF, unconfirmed forecasts and campaign requirements; and national and regional stock levels.

Each week, UNICEF SD will update ViVa with the updated demand info and confirmed deliveries. EPl managers are encouraged to update stock levels and
insert additional campaign requirements frequently to ensure that the tool provides the most accurate stock information.
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b. How does ViVa work?

ViVa uses information from UNICEF Supply Division and country stock info and campaign requirements to generate stock levels, stock projections in time,
and to develop alerts and recommendations for users to take action.

Central Store Manager
EPI Focal Point

unicef &

Supply Division Updates national stock levels

Stock visualizations.
Alerts and
recommendations.

)

Uploads weekly confirmed orders from UNICEF

EPI manager
Monitors stock
projections including
upcoming orders and

ﬁ ﬁ takes action
& & Regional store managers
‘@ EPI focal points

ViVa calculates the current and future stock levels and generates an alert level and recommendation for the user to take action. The data model looks at
current stock, upcoming confirmed orders, upcoming forecasted orders, and potential stock levels, and generates a corresponding alert level and

Updates regional stock levels and order

recommendation.
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¢. Why use VivVa?

ViVa is meant to be used by EPI Managers as a monitoring and advocacy tool. It enables staff from a country’s immunization programme to monitor and
identify potential stock issues, advocate for timely funding, and take action in time.

Before ViVa: delays in informing and communicating stock issues, potential for stockouts

Stockout!
EPI manager Immunization
Regional store informed AL
manager informed Funds Vaccines transferred
transferred Vaccine arrival to regional store
Stock count, Central store Funds UNICER Immunization
levels low manager informed RIqueSt funds appived procIJrement resumes
Today >

After ViVa: easier access to information for decisionmakers, corrective action can be taken in time

EPI manager creates graphs
from ViVa, requests funding

Regiona| store using visual tools
manager informed

EPI manager
monitors in ViVa Vaccines transferred to
Vaccine arrival regional store
Funds
Stock count, transferred
levels low UNICEF

l lprocurement No pause to immunization program, EPI manager

v continues to monitor for potential issues

- |
Today >
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2. Navigating through the site

The following pages provide a general overview of the information presented on the ViVa pages and how to navigate between the pages. Please refer to
Section 3 (“Using ViVa”) for detailed instructions on using the site.

a. Loggingin

Log into ViVa at www.vivaplatform.org using the username and password received from UNICEF Supply Division. Each user will have his or her own
username and login, and can only access the information for his or her own country. From here, you will be directed to the Country Overview page for your
country.

Visibility for Vaccines unicef @ | @)y ears
English Francais
Language —
settings

Welcome to the Visibility for Vaccines (ViVa) website!
ViVais a tool for EPI managers to enable early identification of potential stock issues

Please enter your username and password to continue.

Username

Password

Forgot your password?

About Vivs How to use Viva Contactus



http://www.vivaplatform.org/
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b. The country overview page

After you log into ViVa, you will be directed to the country overview page. You will see the central location and all of the regional locations for your country,
as well as an overview of alert levels for each vaccine.
Vaccine I—| User

C . hames I settings
Visibility for Vaccines unicef @ | )b and
English Francais . Viva User Viva Country - Central 1.t G Iogout
Country M Funding overview = Chart | Edit data
name Country Overview > Below are the vaccine alert levels for all locations in your country Export Eﬂj F Export
Keytoalertlevels: () wign () Medium tow () vosken ® e Options for
this page
. &, o
Location & °© \h‘% &9 & © & &
name and
date o ntral
d A i 0000 [\
last stock \td Alert levels
e 000000 foreach
Updated 25 Apr 2016 .
vaccine

Note: you may only have the central location for your country. Contact your UNICEF focal point if you would like to include regional locations.
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From the country overview page, you can click on either location name or vaccine name to view additional details about these items. Hover your mouse
over each alert level in order to see more detailed information about each vaccine.

Click on the 1) location name, or 2) vaccine alert to see additional details. To edit data about this country, select 3) edit data.

English Francais

Visibility for Vaccines

Country Overview > Below are the vaccine alert levels for all locations in your country.

H i@y | {Zy World Health
u n | Cef \@.\') & Org'anizslaion
. ViVa User ViVa Country - Central {} (>
Edit data
-
Funding overview Chart Edit data

Keytoalert levels: () wigh (1) Medium tow ([ nosten [ ™
o s '3" A g G* & &
e
Kl I & K A e) <
Central Central
Updated 09 May 2016 DTP-HepB-Hib

Region
Updated 25 Apr 2016

What do the alert colors mean?

. Medium alert. Take action soon.
Low alert. Action is advised.

. No need for action at this time.

. High alert. Take action immediately.

Stock [doses)

2,159,496

Stock (months)
2

Time to safety level (weeks)
7

Time to stockout (weeks)
11

Next confirmed order
02 Jun 2016
1,200,000
45145502

Date
Quantity (doses)
PO number

Nest forecasted arder

01 Jun 2018
992,900

Date
Quantity (doses)

Alert
No alert detected for the upcoming period.

2

]

d=2a9c044.26-2b02-4fb4-3120-7fbbffi3d8c7 Blid=64fa398d-2805-... }

10
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c. The location overview page

The location overview (either at central or regional level) provides additional details about the stock levels and recommendations for each vaccine at that
location. Click on vaccine stock level to navigate to the product detail page, or pull down on the current location name to see an overview of a different

location.
Visibility for Vaccines unicef @ | @) sste
English Francais Viva User Viva Country - Central {3 &
Current
location W
Chart Edit data
Location Overview > Below are the vaccine stock levels for the year, alert levels and recommendations in this location. vt @ HE
Keytoalertlevels: (@ vignh () Medium Low [ nostet ® rodas
o Ko & A 2 A <
Stock level e @ € £ & & «
(as percent
of annual
need)

Alert level

11
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d. The product detail page

Clicking on a product provides week-by-week information about a specific vaccine. Today’s date is represented by the thick black line on the chart. The alert
period is shown in yellow. Turn visualization options on and off to see how stock levels will be affected by campaigns, forecasts, etc.

See next page for details about graphs.

Visibility for Vaccines unicef @ | (&)t

English Frangais Wiva User Vivia Country - Central £ G»
Current

vaccine Viva Eaun'. Chart  Edit data

name

Product Detail View > See details of the selected vaccine stock level and projections by week

Please note that forecasts are approximate for the following month, and are not exact. E'xpC - EE
5000000
| 4000000
S tOCk 3000000
levels (see H

ot page) “ »

1000 000

/

e Visualization

2 £ © © © © @ @9 © 9o 9 © £ © @£ © © © © © © © © © © © © © © © © © © © @ © © 9o 9

5 5§ 5§ 5 &8 B 5§ 58 B § & 5 5 5§ § & &8 B & E § & 5§ § 5§ &8 5 &5 5 5 & 5 5 5 58 5 85 § 8

8 8 8 8 8 8 8 8 8 8 § 8§ 8 8§ 8 § 8 R §E §E 8 §8 8 8 8 8 8 8 R 8 8 8 8 8 8 8 8 §8 8§

¢ 5 3 8 ¥ 5 B B B R ¥ ¥ ¥ 5§ 5§ 5 5 3 3 5 3 7 % 7 2 8 § § & g ¥ v v om ® T O B B on / [o)

£ 2 2 2 2 £ 2 2 2 £ 2 £ &5 55 5333332 337 3§ 45488 888888382 8 8 2

g 5 *T 5 & & = 2 8§ g a3 % 8 8 2 B & & - ¥ 8 g 38 & g g 2 ¢ ¢ ®m 8 2 L & 5 5 X o =B
#-STOCKLEVEL @) | - STOCKLEVEL W FORECASTS @) | --mnSTOCKLEVEL @D | ruonsoETALs / Optlons
I CONFIRMED ORDER m FORECASTED ORDER m == MAX STOCK LEVEL m VIEW CAMPAIGN IMPACT

I CAMFAIGH

No alert detected for the upcoming period

Upcoming
Next confirmed order Next forecasted order (approximate)
order

. Dste 02 Jun 2016 Dete 01 Aug 2016

deta’ls Quantity 1,200,000 Quantity 2,400,000
PORItems 4514550210 Funding GAVI
Funding GAVI Activity Routine
Activity Routine

12
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As can be seen below, stock levels are shown as actual projected (including confirmed orders), and potential (with unconfirmed/planned orders). Stock
inputs by the user are shown as a circle, and will adjust the stock lines accordingly.

Visibility for Vaccines unicef @) | G
English Frangais | \iVa User VWiVia Country - Central £} &

WVIVa Cofnitry Central - DTP-HepB-Hib ~ .
Chart Edit data

Max/min
Iu ee details of the selected vaceine stock level and projections by week. e

recommended 32 = approximate for the following month, and are not exact. St @ ﬂg
stock levels

5 000 000

4000000 Potential stock level

1 with forecasts
3 000 000
Actual "

2000 000

stock line « 8

»

1000000

o L= o o o o L= o o o o o o o - L= o o o o o o L= o o o o - o o o o - o
User E R R R R R RR R R & R§ R R 8B 8 R R B ® B B R R R R BERR R REER B ERB §
stock | = = &8 3 5 ¢ 5 3 3 = 3 3 © 8 & 2 = 2 8 3 B 5 & 2 8 8 2 F % 5 5 = 5 A&
5T '-nput m -« ETOCK LEVEL W FORECASTS ‘:) == MIN STOCK L ‘:} FUNDING DETAILS
HcC ‘:) FORECASTED ORDE! I:) —= MAX STOCK L I:) VIEW CAMPAIGN IMPACT
I CAMPAIGN ‘:}
Confirmed deliveries Forecasted orders
(with Purchase Order) (unconfirmed)
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e. Visualization options

Part 2 : Navigation

The visualization toggles that appear below the product chart will turn the visualizations on and off, for the user’s convenience. The controls on the left side
of the screen do not have an impact on the data, but instead make the lines appear or disappear on the chart. These are all turned on as default. The
toggles on the right side will have an impact on the data, and must be turned on by the user.

-8 STOCK LEVEL I‘_} « « BTOCK LEVEL W FORECASTS I‘_} == MIN STOCK LEWEL m FUNDING DETAILS
I CONFIRMED ORDER FORECASTED ORDER m == MAX STOCK LEVEL m WVIEW CAMPAIGN IMPACT
0 B CAMPAIGN m /
Turn visualizations
Turn on for

on and off

View funding details: Turning this visualization on will add more details regarding GAVI and non-GAVI funding, for both confirmed and forecasted orders.

more details

o
2000 000

«

~)

Colored bars to

=
=
=
=
=
=
—

D4 Apr 2016  [S———
1
1
1

differentiate s e gz ee
between GAVI/ $3323 332321
non-GAVI orders , foucce o)
Il WONFIRMED ORDER. (AT} m
[ CONFIRMED ORDER (NON-GAVT) m

08 May 2016

18 May 2016

23 May 2018

3 May 2016 —
Jun 2016

13 Jun 2016

i3]

« + STOCK LEVEL W FORECASTS
[ FORECASTED ORDER (GAUT)

20 Jun 2018

FORECASTED ORDER (NON-GAVT)

27 Jun 2016

71 1.

04 Jul 2016

11 Jul 2016

18 Jul 2018

26 Jul 2016

folels

e © © © © © © © ©L © L © © © © L © @
%4 B 8 ®H ®H B ®H B B 8 ®B 8 8 8 8 8 8 8
g ¥ % % % & § & £ % B B B 2 3 B3 B 3B
= S T - - - -
5 &8 2 ®§8 &8 8 ¢ 2 5 8 2 = & &5 B T g &
== MIN STOCK LEVEL l:) FUNDING DETAILS -‘;
—= MAX STOCK LEVEL m VIEW CAMPAIGN IMPACT

I CAMPAIGH ‘:}

Additional toggles to view
orders by GAVI/non-GAVI

14
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View impact of campaign: This will show the effect of a campaign on the projected stock levels. See Section 3 (“Using ViVa”) for more on campaigns.

f. The funding overview page

The funding overview page provides indicative information about the percentage of GAVI and non-GAVI funding for each vaccine during the past years,
based on UNICEF SD data. Access this page from the country overview page by clicking on the “Funding Overview” tab.

Visibility for Vaccines unicef @ | @) bxaran
English Frangais Nt nEReL i TS NaVigation
tab

Viva Country

Funding overview Chart Edit data

Funding Overview > Below is an overview of GAVI/non-GAVI funding for your country, in doses and overall funding.

Please note, this information is for reference only and should not be used for reporting purposes.

.
R )
& & :\& &Q@\o & & & & %

2016

2015 Central h
b iy Percentage of the
S i e vaccine funded
e by GAVI

90
Percent non-GAVI funding
10

NOTE: The Funding Overview should not be used for reporting purposes. The data is intended to provide a general picture of GAVI funding only, and may
contain errors.

15
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3.Using ViVa

Users are able to add and edit certain data that is specific to their own country, such as entering stock levels, inserting campaign information, and setting
recommended maximum and minimum stock levels for his or her country. Additional modifications, such as uploading order information, and adding
vaccines or regional locations, is done by UNICEF SD.

ViVa has two levels of information: central and regional level. As seen below, at central level, ViVa uses information from both UNICEF SD and the country’s
own data. At regional level, ViVa uses only country data and does not capture UNICEF information. This section covers general functions and editing data at
central level. Please refer to "Section 4: Regional level” for more information about using ViVa at regional level.

AT REGIONAL LEVEL

UNICEF EPI UNICEF EPI
sD Manager sSD Manager

Insert/modify stock levels X v Insert/modify stock levels X v
Insert/modify annual requirements v v Insert/modify annual requirements X v
Insert/modify planned o X Insert/modify planned X J
(unconfirmed) orders {unconfirmed) orders
Insert/modify confirmed orders N X Insert/modify confirmed orders X v
Insert/modify campaign requirements X v Insert/modify campaign requirements X v
Add/remove a vaccine v X
Add/remove a regional location v X

16
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All data is modified using the “Edit Data” tab found on each page. The “Edit Data” tab appears at country, location, and product detail pages, and will
enable the user to customize or input data separately at each level.

At country overview page, edit data allows you to:

e Change the time period for calculating alerts

e Change the recommended minimum and maximum stock levels for all locations in the country
At location overview page, edit data allows you to:

e Insert campaign requirements for every vaccine

e Add a description for the location, such as a comment on upcoming campaign

e Change the recommended minimum and maximum stock levels for that particular location
At product detail page, edit data allows you to:

e Edit programmatic data (annual requirements) for the specified vaccine. This information is uploaded by UNICEF, but can be modified by the
user if requirements have changed.

e Enter stock counts.

Viva Country ) ) .
Funding overview Chart Edit data

Country Overview > Below are the vaccine alert levels for all locations in your country.
or I X EE|

Key to alert levels: () wign Medium tow ([ vosten ® v

Central
Updated 09 May 2016

17
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a. Entering stock counts

The ViVa tool works best with the most accurate stock level data. The more frequently stock levels are updated per vaccine, the more accurately ViVa can

Part 3 : Using ViVa

provide projections for overstocking and stockouts. We recommend updating the ViVa tool each time there is a vaccine stock movement.

When you first use ViVa, you will see no stock data, because this information must be updated by the country user. From the product detail page, you will
see the confirmed and forecasted orders, and the recommended min/max stock level bars, which are uploaded by UNICEF. However, there will be no blue

line to indicate stock levels. You must create an entry.

Click on “Edit Data.”

Viva Country + Central» YF~

Product Detail View > See details of the selected vaccine stock level and projections by week.

Cha Edit data

@) B

) ) Export
Please note that forecasts are approximate for the following month, and are not exact. -
1750 000
1 500 00O
1250 000
1000 D00
o
L5}
&
[+]
=
« 750 000
500 000 I
250 000
0
@ w oW o® ® oW W W W @ W ® W W W W W W ® W w ® W W W W @ ®@ ® W ®w ®w w @ ® ®w W w @ @
S &5 &5 &5 5§ &5 &5 &5 & &5 &5 5§ &5 &8 & & &5 &5 5 &8 5 & &8 &5 &5 &5 &8 5§ 5 &8 &5 &5 &5 & 5 5 8 &5 8 &
o™ o™ lxl ™~ ™ o o o™ o™ ~ ™ o™ o o™ o™ ™~ [y ] o o la} o~ ™~ o o~ o~ o™ o~ ™~ [y ] o™ o o~ o~ ™~ o~ o~ o o™ o~ ~
o 5 5 5 5 5 5§ 5§ § & ®™ m ™ = £ £ E E 5 3 3 S D O9 O ooo@m g oo oo a8 ¥ o8 g g oz oz o= o=
& 2 2222232285858 33333Z32:323232 3788883060606 8 2222
55 83 %28 dggegg 82 RESTFE s 8w gdged 282 EdR5 58
—8-STOCK LEVEL ‘:} « « STOCK LEVEL W/ FORECASTS m == MIN STOCK LEVEL ‘:) FUNDING DETAILS
| CONFIRMED ORDER m FORECASTED ORDER I:) -~ MAX STOCK LEVEL m VIEW CAMPAIGN IMPACT
I CAMPAIGN ‘:)

18



ViVa - Visibility for Vaccines User Manual Part 3 : Using ViVa

You will see settings for this product. Select “stock input.”

Viva Country Central~ YF~ )
Chart Edit data

Programmatic Data Product Settings

Stock input You can enter or modify the programmatic data here, and enter regular stock counts for this vaceine. At regional level, you have additional options to enter confirmed and

unconfirmed orders.

You will see a list of the previous stock updates (in doses). Since you have not added a stock entry yet, the list is blank. Click on “Create Entry.”

Viva Country Central » YF~ _
Chart Edit data

Programmatic Data Stock input
Stock input Previous stock entries (in doses)
Date Quantity (doses)
Create Entry

19
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You will be prompted to select a date and quantity (in doses) for the stock count. Click on “Save” after entering the data.

English Francais
« April 2016 »

Viva Country « Central ~ YF~ 27 28 29 30 31 1 2

10 11 12 13 14 15 16

Programmatic Data Stock Input
17 18 19 20 21 22 23

Stock input Please enter date and recorde % 25 26 27 28 29 30
1

-

2 3 4 5 6

Date | 24/04/2016

Quantity (doses) 750000

Save Back to list

You will now see the stock count recorded. Click on “chart” to see this reflected in the visualization.

Viva Country = Central+ YF~ _
Chart Edit data

Programmatic Data Stock input
Stock input Previous stock entries (in doses)
Date Quantity (doses)
24/04/2016 750 000 Edit Delete

Create Entry
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Part 3 : Using ViVa

You will now see the stock input, shown as a circle, and the projected stock line based on the annual programmatic data. Please note that the stock line will
appear suddenly, since ViVa did not have stock information before this first stock input.

You will also see the projected stock lines now, including confirmed orders (in dark blue), and forecasted orders in grey.

Your
stock
input

Viva Country Central = YF~

Product Detail View > See details of the selected vaccine stock level and projections by week.
Please note that forecasts are approximate for the following menth, and are not exact

1750 000

1500 000

Chart Edit data

o 0

1250 000

1000 000

0 000

?doses

500 000

. I
250 000 | |
0

6
6
6
6
6
]
6
6
]
6
6
]
6
6
]
6
3

Z &5 5 &5 &5 5 & 5 &5 55 &5 555 5 B
§ 8 8 8 R 88 88 R 88888 88 8
P 528 E55% 53583558555
% 5 2 5 83 F 2 &8 3dgegg 828

-8-STOCK LEVEL m + « STOCK LEVEL W/ FORECASTS

COMFIRMED ORDER m FORECASTED ORDER

3

27

04

5
6
|
-]
5
5
6
E
6

S 5 5 5 5 5 5 5 5 55555555 5 5
g 8 88 8 8 8’8 s 888888 a8 88
= 3959 % % 2 88 & 8 5353 5 535 2% 3 3 3
s T T A A T B o0 ow oW 2 g E 9, 9 z =z =z =
s 82 gR 8T 2T ELEF S aAae BT TR
== MIN STOCK LEVEL m FUNDING DETAILS
-~ MAX STOCK LEVEL m VIEW CAMPAIGHN IMPACT
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The ViVa stock line will adjust every time you update your stock count, to move the stock line to the position of the stock input
count by clicking on “edit data,” entering data, and saving. Click on “chart” to see the impact on the visualization.

. Let’s enter a new stock

Programmatic Data Stock input
Stock input Previous stock entries (in doses)
Date
15/05/2016
24/04/2016

Quantity (doses)
650 000 Edit Delete
750 000 Edit Delete
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You will see a new stock input dot, and the stock line will have adjusted to the new level.

ViVa will only show stock projections for up to one year from the last stock input. The stock line will disappear if no stock inputs have been made for one
year. To ensure the most accurate stock projections, please be sure to input stock counts on a regular basis.

Viva Country » Central ~ YF~ _
Chart Edit data
oduct Detail View > See details of the selected vaccine stock level and projections by week. Export ﬂ
) ; xport: E
Your new ase note that forecasts are approximate for the following menth, and are not exact. p en
stock input
readjusts
the stock
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Please note: the consumption rate will remain the same unless you edit the “programmatic data.”

% % %k %k
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b. Modifying vaccine consumption rates

Part 3 : Using ViVa

ViVa calculates the rate of consumption based on the “programmatic data.” These are the annual requirements per vaccine collected by UNICEF and
uploaded into ViVa once a year. The programmatic data is also the basis for calculating the recommended minimum/maximum stock levels per vaccine.

Min/max levels
are based on
programmatic
data

Viva Country = Central » YF~

1750 000

1250 000

1000 00D

« 750 000

500 00D

doses

= 1500 D00

Rate of consumption
is based on port
programmatic data

Product Detail View > See details of the selected vaccine stock level and projections by week
Please note that forecasts are approximate for the following month, and are not exact

Chart Edit data

m B3

250000

29 Feb 2016
07 Mar 2016
14 Mar 2016
21 Mar 2016
28 Mar 2016
04 Apr 2016

-8-STOCK LEVEL
I CONFIRMED ORDER

No alert detected for the upcoming period.

11 Apr 2016

/£

18 Apr 2016
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30 May 2016
06 Jun 2016
13 Jun 2016
20 Jun 2016
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25 Jul 2016
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05 Sep 2016
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Part 3 : Using ViVa

You may wish to modify this programmatic data to account for an increase or decrease in annual vaccine needs or usage rates, or if you are using ViVa for a
new vaccine that does not have historical data. Click on “Edit Data” and then “Programmatic Data” to view the vaccine requirements as entered by UNICEF

SD. ViVa will only use the current year or previous year’s programmatic data to calculate consumption, so please ensure that data exists for these years.

You can create a new entry for 2016 requirements. Click on “Create new entry.”

Viva Country ~ Central ~ YF~
Chart Edit data
Programmatic Data Programmatic Data
Stock input Below are the annual requirements for the specified vaccine, based on UNICEF historical data. If no data exists for the current year, Viva will calculate vaccine consumption rate

and min/max levels based on the previous year's data. Please update or edit if necessary.

Year Quantity (doses)

2015 4656 423 Edit Delete
2014 5442701 Edit Delete
2013 6715026 Edit Delete

Create new entry

You will be asked to enter the year and the annual requirements, in doses. Press “save.”

Viva Country = Central - YF~ Chart Edit data
Programmatic Data Programmatic data
Stock input Enter the requirements for the year in doses.

Year 2016
Quantity (doses) | 8500000] x
Save
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Part 3 : Using ViVa

The new annual requirements will appear on the list, and will now be used to calculate the consumption rate and minimum/maximum levels. Click on

“chart” to see the impact of the new requirements.

Wiva Country ~ Central - YF~
Chart Edit data
Programmatic Data Programmatic Data
Stock input Below are the annual requirements for the specified vaccine, based on UNICEF historical data. If no data exists for the current year, Viva will calculate vaccine consumption rate
and min/max levels based on the previous year's data. Please update or edit if necessary.
Year Quantity (doses)
2016 & 500 000 Edit Delete
2015 4658 423 Edit Delete
2014 844270 Edit Delete
2013 6715026 Edit Delete
Create new entry
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The rate of consumption and minimum/maximum levels will have changed to reflect the new annual requirements. Since the stock levels have changed
with regards to recommended min/max levels, the alert level has also changed.

Wiva Country = Central » YF~ .
Chart Edit data
Product Detail View > See details of the selected vaccine stock level and projections by week. { j EE
Flease note that forecasts are approximate for the following month, and are not exact. =2
. 3000 000
Increased min/max
levels to reflect new 2500 000
requirements
2000 000
@
8
@ 1500 000
=
l I 1000 000 /\ l l
‘\
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o |
I R T R T R T T T T S O B B R S S S
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5 s &3 F 2 8 ggegg & 8&8Ke - - d g geggygygdesg st 3dSE g g8
reflect updated g8 = He
. . -8-STOCK LEVEL + + STOCK LEVEL W/ FORECASTS ==MIN STOCK LEVEL FUNDING DETAILS
StOCk situation CONFIRMED ORDER FORECASTED ORDER MAX STOCK LEVEL VIEW CAMPAIGN IMPACT
I CAMPAIGN
You are heading towards stock out soon, and confirmed orders will not be sufficient. Place a new order immediately.

Please note: ViVa takes only the previous year’s requirements to estimate requirements for the following year. For example, it will take only 2015 data to
calculate the requirements for 2016, and disregard 2014 data. You must have programmatic data for the current or previous year.

% %k %k %k
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c¢. Adding campaign requirements

ViVa enables you to add or edit any additional requirements that would have an impact on stock levels and consumption, such as campaigns or outbreak

Part 3 : Using ViVa

responses. The tool allows you to enter the number of doses per vaccine, as well as the duration of the campaign. The tool will then include this figure into
the projected stock levels and enable you to visualize the impact of a campaign on future stock levels.

Enter campaign information on the location overview page. This provides one place to have an overview of all upcoming campaigns per location.

Go to the location overview page, and click on “edit data.”

Vivia Country -

Location Overview > Below are the vaccine stock levels for the year, alert levels and recommendations in this location.

Key to alert levels: . High . Medium Low . No alert . No data

Chart Edit data

@ 08
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You will see the available settings for this location. Click on “Campaigns” to add a new campaign for this location.

Vive ouniy Chart
| Campaigns I Location Settings

Location Description You can add a campaign, add a comment or note for a location, and set recommended stock levels for this location.

Recommended stock levels
Campaign: You can insert a planned vaccination campaign here to see the impact on potential stock levels.

Location description: Enter a comment or note for this location, which will appear at the country overview level. The comment will remain until you delete it.

country level. Default is 12 weeks (min) and 32 weeks (max).

Edit Data

Recommended stock levels: You can set minimum and maximum recommended stock levels (in weeks) for this location. This will override the recommendead stock levels if previously set at the

Past campaigns will appear here. Press “create new campaign” to enter campaign details.

Vv ouny Chart
Campaig "

Location Description

Recommended stock levels Product Start Date End Date Doses

Create new Campaign

Edit Data
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Select the vaccine, number of doses required, and the start and end date for the campaign.

Part 3 : Using ViVa

Ve ountry

Chart Edit Data
Location Description Enter campaign information for this location
Recommended stock levels
Product oPV
Doses 40000000
Start Date 01/05/2016
End Date 27/05/2016
Save Back to list
Press “save.” Your campaign will now appear on the list of campaigns for this location.
WViva Country Central ~ .
Chart Edit Data
Campaigns
Location Description
Recommended stock levels Product Start Date End Date Doses
oPv 01/05/2016 27/05/2016 40000000 Edit Delete

Create new Campaign
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View the campaign on the chart by navigating back to the product detail page. You will now see the campaign on the chart, represented by red bars for
each week of the campaign.

Viva Country Central » OPV~
Chart Edit data

Product Detail View > See details of the selected vaccine stock level and projections by week. S E EE
Please note that forecasts are approximate for the following month, and are not exact Xport: o3

Vaccine campaign
bars
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01 Aug 2016
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28 Nov 2016
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FORECASTED ORDER

oo

o £
I CONFIRMED ORDER == MAX STOCK LEVEL VIEW CAMPAIGN IMPACT I

ICAMPAIGN

Note that there is no change to the stock projection levels at this point. To see how the campaign will have an impact on future stock levels, you must
toggle view impact of campaigns.
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Turning on the campaign data visualization allows you to see how the campaign will affect the stock levels. As you can clearly see in the example below,
implementing the campaign during the time indicated will have a drastic impact on the stock levels, and may require confirming an order from UNICEF

earlier, or modifying the scope of the campaign.

Part 3 : Using ViVa

Wiva Country - Central - OPV~ )
Chart Edit data
Product Detail View > See details of the selected vaccine stock level and projections by week. Export: EE
Please note that forecasts are approximate for the following month, and are not exact. D (21
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Note: the “campaign” toggle will only make the red campaign bars appear or disappear from the chart, and does not have any impact on stock projections.
Use “view impact of campaign” to see the effect on stock levels.

% 3%k %k %k
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d. Adding a location description

You can add a comment for a regional or central location, which will be displayed on the country overview and location overview page. This may be

Part 3 : Using ViVa

necessary if, for example, you want to alert colleagues of an impending campaign, or of action that has been taken in response to an alert.

Ared flag I~ will appear next to the location name if there is a description attached.
Wiva Country ) ) )
Funding overview Chart Edit data
c o iew > Bel th i lert levels for all locati i try.
uum.ry vVerview elow are the vaccine alert levels 1or all locations In your country E}(p::ﬂ: @ EE
Key to alert levels: . High . Medium Low . No alert . No data
o R o & A o A & «
. O R o g Q < BN
Location < Lo < d <
description
seomment [N i XXX .
Updated 09 May 2016
gion
X ee0VOO®
[* Approaching stockout of BCG. Order from Central Store on 20 May. expected arrival 1 June.

To add a location description, go to the location overview page and click on “edit data.” You will see an option for adding a location description.
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Viva Country Region~
Chart Edit Data

Location Settings

Location Description You can add a campaign, add & comment or note for a location, and set recommended stock levels for this location.

Recommended stock levels

Campaign: You can insert a planned vaccination campaign here to see the impact on potential stock levels.
Location description: Enter a comment or note for this location, which will appear at the country overview level. The comment will remain until you delete it.

Recommended stock levels: You can set minimum and maximum recommended stock levels (in weeks) for this location. This will override the recommended stock levels if previously set at the
country level, Default is 12 weeks (min) and 32 weeks (max).

You can add a temporary comment or permanent description for the location. The description will remain until it is deleted.

Viva Country Region~ )
Chart Edit data

Campaigns Location Description

Location Description Add a commentfote for this location. This will be viewed at the Gentral location until you remove the comment. Maximum characters: 200.

Recommended stock

levels Approaching stockout of BCG. Order from Central Store on 20 May, expected arrival 1 June.

Save

%k %k %k %k
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e. Setting recommended stock levels

By default, the recommended minimum and maximum stock levels are set to 12 weeks (min) and 32 weeks (max) for all vaccines in all locations. You may
need to adjust these levels for a specific location based on your supply strategy. For example, if you receive the entire programmatic requirement in one
delivery at the beginning of the year, you may want to adjust the overstocking to 52 weeks to minimize the number of alerts received.

Since the alert levels and recommendations are based on the recommended stock levels and alert period, changing these parameters will have an impact
on the calculations as well as the triggering of alerts.

You can change the recommended stock levels at country level (for all vaccines and all locations in your country) or at location level (for all vaccines in a
single location).

To change the recommended stock levels for one location only, click on “edit data” from the location overview page.

Wiva Country Central ~ .
Chart Edit data

Location Overview > Below are the vaccine stock levels for the year, alert levels and recommendations in this location. { j EE
Key to alert levels: . High Medium Low . Mo slert . No data
o &Q'Q}_ & Ry A\ Ry {K <
) < > Q < K\
< 28 ® & { Q Q
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Then click on “Recommended stock levels.”

Viva Country Central ~ .
Chart Edit Data

Campaigns Location Settings
Location Description You can add a campaign, add a comment or note for a location, and set recommended stock levels for this location.
I Recommended stock levels I
Campaign: You can insert a planned vaccination campaign here to see the impact on potential stock levels.

Location description: Enter a comment or note for this location, which will appear at the country overview level. The comment will remain until you delete it.

Recommended stock levels: You can set minimum and maximum recommended stock levels (in weeks) for this location. This will override the recommended stock levels if previously set at the
country level. Default is 12 weeks (min) and 32 weeks {max).

You will have the option to change the minimum and maximum stock levels, in weeks. In the below example, we will change the min/max levels from the
default levels. Press “save” and click on “chart” to see the impact of this change on the recommended stock levels and the alerts.

Viva Country Central ~ )
Chart Edit Data

Campaigns Recommended stock levels
Location Description Please set the minimum and maximum recommended stock levels, in weeks, for this location. Defaults are set at 12 weeks (min) and 32 weeks (max). Please note, this will override the recommended
levels set at country level.
Recommended stock levels
Minimum level (weeks) 4
Maximum level (weeks) 16| X

Save
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Changing the recommended stock levels will also change ViVa’s alert calculations. As you can see below, the alert levels have now changed to reflect the

decreased recommended stock levels.

Part 3 : Using ViVa

Viva Courtry

Key to alert levels: . High . Medium

Low

. Mo alert

. Mo data

Location Overview > Below are the vaccine stock levels for the year, alert levels and recommendations in this location.

Chart

Export:

Edit data

@ K

«

%k %k %k %k
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f. Adjusting alert periods

The default alert period is set to 12 weeks. This is the period of time that ViVa will calculate the current and potential stock levels for generating an alert
level. You can change the alert period if your vaccine lead time is much shorter or much longer, to generate a more accurate picture of your stock situation.

In the below example, no alert is generated for the vaccine, as the vaccine stock levels will be within min/max levels during the majority of the alert period.
Let’s increase the alert period to 24 weeks.

Alert period for calculating stock
levels and generating alerts

Chart tdit data

@ B2

Product Detail View > See details of the selected vaccine stock level and projections by week.
Please note that forecasts are approximate for the following month, and are not exact.
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No alert detected for the upcoming period.

To change the alert period, navigate to the country overview page and click on “Edit data.” Then select “Alert Period.”
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Part 3 : Using ViVa

Wiva Coun

r
Alert Period I

Recommended stock levels

Country Settings

Settings that will apply to all focations in this country

Funding Overview Chart

Edit Data

Alert period: The time period, in weeks, that Viva will calculate to generate an alert. ViVia will review actual stock levels, upcoming orders, and potential stock levels for each week during the alert
period to trigger an overall alert and recommendation. The default alert period is set to 12 weeks, and can be changed here to be more sensitive (shorter alert period) or less sensitive (longer alert

period).

Recommended stock levels: These are the minimum and maximum recommended stock levels for all vaccines in the country. Default is set to 12 weeks (min) and 32 weeks (max). This setting is

also available at the location level, which will override the country level settings.

We will change the alert period to 24 weeks. Press “save,” and click on “chart” and select the right vaccine to see the impact on the alert level.

Viva Country

Recommended stock levels

Alert Period

Enter the alert period in weeks. The default alert period is 12 weeks.

Number of weeks

24

Save

Funding Overview

Chart

Edit Data
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The new alert period will be reflected on the chart, and ViVa will now generate a new alert and recommendation since it will assess the stock levels over a
longer period of time. The new alert reflects a stockout for the majority of the alert period.

New alert period

Wiva Country Central ~ DTP-HepB-Hib~
Chart Edit data

Product Detail View > See details of the selected vaccine stock level and projections by week - Eﬂj EE
Export:

Please note that forecasts are approximate for the following month, and are not exact.
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Stocks levels will be below buffer soon, and confirmed orders will not be sufficient. Place a new order immediately.

% % %k %k
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g. Routine vs. supplementary

ViVa is intended to be used for both routine and supplementary vaccine requirements. However, for simplicity and ease of use, the program combines
these two into a single stock level and projection.

When entering confirmed and forecasted orders at the region level (see Section 4), the user can distinguish between activity types. These will be combined
into the graphs together.

If the user requires that routine and supplementary vaccines be treated separately, please contact your UNICEF focal person or the ViVa administrator at
viva@unicef.org, who will assist in creating separate products for the two activity types.
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4.Using ViVa at the regional level

Part 4 : Using ViVa at regional level

As mentioned in Part 3 (“Using ViVa”), UNICEF SD does not have any information at regional level. All information must be created and updated by the
country user at regional level. The user must input programmatic data and insert confirmed/forecasted orders, as well as update stock count.

When you first navigate to a regional location, you will notice that all alert levels are grey, indicating that ViVa does not have any data to calculate an alert.

Viva Courtry

Location Overview > Below are the vaccine stock levels for the year, alert levels and recommendations in this location.

Mo upcoming orders

Mext forecasted order

Mo upcoming demand

Alert

Mot encugh data to calculate current situation

Key to alert levels: . High . Medium Low . Mo alert . No data
& .
e & 2@
%O @Q‘Q\é\\‘o \xg;b
Region
BCG
Stock (doses) {t?
o
Stock (months)
No information ’
. Time to safety level (weeks)
is uploaded at 0
region al Ievel ;ime to stockout (weeks) 0| e o o
by UNICEF Mext confirmed order

Chart Edit data

@ B

Click on a vaccine product, and you will see no information: no recommended stock levels, no stock line, and no order information. You must input this

information manually.
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doses

Viva Country Region~

Product Detail View > See details of the selected vaccine stock level and projections in time
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Part 4 :

Using ViVa at regional level

No min/max levels, no
stock lines, and no
order information will
exist until the user
inputs these manually

Click on “edit data” and add programmatic data and a stock input. You will see recommended stock levels, # doses, and a stock level line. Please refer to the
previous section for instructions on adding programmatic data and stock input. The following section covers entering confirmed and forecasted orders.

«
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50000

Viva Country Region ~

Product Detail View > See details of the selected vaccine stock level and projections in time:

Chart Edit Data
Export @ EE EE
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Aug 08 - 2016
Aug 15 - 2016
Aug 22 - 2016
Aug 29 - 2016
Sep 05 - 2016
Sep 12- 2016
Sep 19-2016
Sep 26- 2016
Oct03 - 2016
Oct17-2016
Oct24 - 2016

Jun 20 -
Oct 10 -

User has added
programmatic data
(annual needs) and
stock input
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Please note that the below commands are only available at regional level.

a. Adding a confirmed/forecasted order

From the product detail page, click on “edit data.” You will see two additional options at regional level that do not exist at central level: confirmed order
and forecasted order. Click on “confirmed order.”

Visibility for Vaccines unicef@® G dumaia

English Frangais ~ ViVa User ViVa Country - Central £} G»
Viva Country Region - BCG~ .
Chart Edit Data
Confirmed Orders Product Settings
Unconfirmed Orders You can enter or modify the programmatic data here, and enter regular stock counts for this vaccine. At regional level, you have additional eptions to enter confirmed and unconfirmed orders.

Programmatic Data
9 Programmatic Data: These are the annual requirements for this vaccing, and is the basis for calculating the recommended min/max levels and consumption rate of each vaccine. This will be automatically entered by UNICEF if

Stock | . historical data for this vaccine exists. In case requirements have changed, or this is a new vacdine without historical data, you can enter or edit the annual national requirements for the specified vaccine.
ock inpu

(Please note: ViVa calculates programmatic data based on the previous year's data only, and does not calculate data from 2014, 2013, etc. If no 2016 or 2015 data exists from UNICEF, then you must
enter this manually or you will not hawve min/max levels or stock consumption.)

Stock input: These are the regular stock counts and should be entered regularly for the specified vaccine to ensure that Viva shows the most accurate information.

Settings available for regional locations only
Confirmed orders: These are the confirmed orders or stock movements that are scheduled to arrive at the regional location, and will have an impact on stock projections.

Unconfirmed orders: These are the planned/unconfirmed orders or stock movements that are scheduled to arrive at the regional location, and will not have an impact on stock projections.
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You will see a list of confirmed orders, including date, quantity (in doses), source of funding (GAVI or Non-GAVI), and type of activity (routine or
supplementary). Click on “create new entry” to insert a confirmed order.

Viva Country Region - BCG~ )
Chart Edit Data
Confirmed Orders Confirmed Orders

Unconfirmed Orders

Programmatic Data Date Quantity (doses) Funding source Activity Type

Stock input
Create new entry

Enter the date of arrival, quantity of the order (in doses), source of funding, and activity type. Press “save.”

Viva Country Region » Chart Edit data
Confirmed Orders Confirmed Order Input

Forecasted Orders

Programmatic Data Date 21/06/2016
Stock input
Quantity (doses) 50000
Funding source GAVI
Activity Type Routine

Save Back to list
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You will now see the order in the list of confirmed orders. Click on “chart” to see how the order will appear on the chart.

Confirmed Orders Confirmed Orders

Forecasted Orders

Programmatic Data Date Quantity (doses) Funding source Activity Type

Stock input 21/06/2016 50 000 GAVI Routine Edit Delete

Create new entry

The order will appear as a blue bar, and the stock projection will increase to account for the confirmed order. Details will appear in the box below.

Confirmed order

doses
n
=

50000
N | —
e e & @ e &€ £ ¢ £ ¢ 2 £ ¢ £ £ £ £ £ £ £ £ @ £ £ £ £ £ £ £ £ £ £ £ £ £ @
= s 8 =8 % %8 8 ®% & 8 " 8 8 " A 8 AR A B A A R B 8 8 ® 8 ® &8 & "8 & 8 8 & 8
S s 5 5 Y » = = = = £ £ E 5 5= 3 3 ® = = 2 ® =2 = © =° ® % ¥ B ¥ 2 2z =z =
£ : 2 2 £ £ £ £ £ £33 3333 332333 33 484848480686 64882 2 2 2
E s 3 = % g g8 2 g 8 8 2 R E S - - & 5 g8 =9 g g 58 ¢ 2 §5 8% 5 & &5 5 r 587
-#-STOCK LEVEL m -+ STOCK LEVEL W! FOREGASTS ‘:) == MIN STOCK LEVEL m FUNDING DETAILS
[ CONFIRMED ORDER m FORECASTED ORDER m —~ MAX STOCK LEVEL m WIEW CAMPAIGN IMPACT
mciese
No alert detected for the upcoming period.
Next confirmed order Next forecasted order (approximate) J
—
Dste 21 Jun 2016 No upcoming forecasted orders
Quantity 50,000
PO#Hems i
Funding GAVI
Activity Routine
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Follow the same process to add a forecasted order.

Part 4 : Using ViVa at regional level

Viva Country Region~

Confirmed Orders Unconfirmed Orders

Unconfirmed Orders

Programmatic Data Date

Stock input 23/07/2016 50

Create new entry

Quantity (doses)

Funding source Activity Type

000 GAVI Supplementary Edit

Delete

Chart Edit Data

You will now see the forecasted order (grey bar) appear on the graph, with a potential stock line also appearing. Details will appear in the box below.

01e
01e
01e
01e

28 Feb 2018
07 Mar 2
14 Mar 2018
21 Mar 2
28 Mar 2
04 Apr 2018
11 Apr 2
18 Apr 2018
26 Apr 2018
02 May 2018
08 May 2018
18 May 2018

-9 STOCK LEVEL

ol

[ CONFIRMED ORDER

Next confirmed order

Date
Quantity
PO#litem
Funding
Activity

+ =« STOCK LEVEL W/ FORECASTS

FORECASTED ORDER

© T 8 B B ® © ® ¥ B B B L B ¥ ¥ ® ®© BB oL B O ° BV oV Q ©
&8 §E E R E 8 8 R R R R R 8 8 8 8 8 8 8 8 B B 8 8 8 ® B B§
¥ ¥ 5 5 5 5 3 3 3 3 § § % % % & & & & B E E B E 3 B 3 3B
= = > = 3 2 2 2 4o 04 <2 42 4 2 & & &4 a @ @ 0 0 0o = = =z =
m =2 ¥ o g 5 & = A £ g v g 8 §w oo oz o 28 2 "= oo oE ¥ o= @
2 8 8 2 &8 § 5 8 2 § 8 8 ¢ 2 § 5 £ & &

m - MAX STOCK LEVEL VIEW GAMPAIGN IMPAGT

I CAMPAIGN

olsls

‘ == MIN STOCK LEVEL | FUNDING DETAILS

No alert detected for the upcoming period.

Next forecasted order (approximate)

21 Jun 2016 Date 23 Jul 2016

50,000 Quantity 50,000

! Funding GAVI

GAVI Activity Routine
Routine

Forecasted order

Order details
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5. Other functions

a. E-mail alerts

ViVa provides the ability to enable e-mail alerts of the vaccines in your country or location (depending on your user profile). You can choose to receive these
alerts daily, weekly, or monthly. To subscribe to the e-mail alerts, click on the “user settings” icon from the top-right navigation on each page.

From here, you can select the frequency of the mail alert, as well as select the preferred language for e-mail.

Visibility for Vaccines unicef @ | @) Sauisas

English Francais . Viva User Viva Country - Ced |

Viva Country ) )
Funding overview Chart Edit data

Country Overview > Below are the vaccine alert levels for all locations in your country.

Keytoalertlevels: () vigh (1) Medium tow [ rosken ® v

~, Viva User ViVia Country - Central £ %

Mail alert settings

Subscribe to mail alerts

Q7 ]
o <§ pe %QJ:, a Mail Frequency
& R & <
e ®  Daily
@] Weekly
IMonth
Central o Y
Updated 09 May 2016 Preferred language
@®  English
@] Francais

7y

Region
Updated 25 Apr 2016 Save Cancel

Password options

Change your password
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b. Export options

One of the key functions of the ViVa tool is the ability to generate easy-to-use charts of stock projections for communication with decision-makers and
other partners responsible for funding and stock management.

ViVa can generate PDFs as well as the raw data in .csv format (readable in Excel).

To export the page, click on one of the icons in the “export” section on each page and select “save” to download the file.

Funding overview Chart Edit data
' Export options

Country Overview > Below are the vaccine alert levels for all locations in your country. = - @ EE /
EXport:

Key to alert levels: . High . Medium Low . Mo alert . No data

& o
O QO @ ¢ A -~ Y &
e ea@\(@ & K & & <& B\

Central

Updated 09 May 2018

Region

Vpdated 25 Apr 2018 . . . . . . .

1% Approaching steckout of BCG. Order from Central Store on 20 May, expected srival 1 June.

Do you want to open or save UNICEF VIVA.pdf (127 KB) from dev.vivaplatform.org? Open Save | ¥ Cancel x
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6. Troubleshooting

Below are common questions when using the ViVa tool. Please contact your UNICEF focal point if you need additional assistance.

a. Maximum and minimum recommended stock lines disappear

Your programmatic data is more than one year old. Go to a vaccine -> Edit Data -> Programmatic Data to insert the current or previous year’s plan.

Viva Country Region~

Product Detail View > See details of the selected vaccine stock level and projections by week.

Chart Edit data

: Export: ﬂﬂ
Please note that forecasis are approximate for the following month, and are not exact. £ ED
500 000
________________ .
|
i
400 D00 ]
i
1
1
i
300 000 i
w i
4 i
8 !
= 1
« 200 000 H »
\
i
]
\
---------------- \
100 000 L
L
L
il
Ay
A
a A
LT T R T B O e R T T S S N S B
T 5 &5 5 &5 5 &5 5 5 5 &8 5 5 &5 5 &5 5 & 5 &5 5 &8 5 5 5 58 5 &85 585 &8 55 &5 5 &8 5 & &
ggsasasessagaaggagadadgagadsagsdgdgaaedaassadssdsaqaq
e o e w o= £ o= - S S S Lttt 335 3
2 2 484848485 35 35 8 @ @@ g 2222 TSI LI LEEEE S I3 32332232373
%" B E¥a &8 3 - 2858288583835 728 ggeqg8 288 K° - -8 5894
-8-STOCK LEVEL ‘:) - » STOCK LEVEL W/ FORECASTS ‘:) == MIN STOCK LEVEL FUNDING DETAILS
[ CONFIRMED ORDER ‘:) FORECASTED ORDER ‘:) -~ MAX STOCK LEVEL VIEW CAMPAIGN IMPACT

olsle

M CAMPAIGN
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b. Stocklevel lines are flat

You have a stock input, but do not have programmatic data for this vaccine for the current year. Please insert programmatic data for this vaccine by going

to Edit Data -> Programmatic Data.

Part 6 : Troubleshooting

Viva Country Region~

600 00D
500 000
400 00O
300 000

| | 200 00D

100 00D

doses

Product Detail View > See details of the selected vaccine stock level and projections by week.
Please note that forecasts are approximate for the following month, and are not exact.

Export:

Chart

Edit data

@ G

29 Feb 2016
07 Mar 2016
14 Mar 2016
21 Mar 2016

--STOCK LEVEL

I CONFIRMED ORDER

28 Mar 2016

04 Apr 2016

11 Apr 2016

18 Apr 2016
25 Apr 2016

ols

02 May 2016

09 May 2016
16 May 2016
23 May 2016
30 May 2016
06 Jun 2016
13 Jun 2016
20 Jun 2016
27 Jun 2016

« « STOCK LEVEL W/ FORECASTS

FORECASTED ORDER

04 Jul 2016

11 Jul 2016
18 Jul 2016

ols

25 Jul 2016

01 Aug 2016
08 Aug 2016
15 Aug 2016
22 Aug 2016
29 Aug 2016

==MIN STOCK LEVEL
== MAX STOCK LEVEL

W CAMPAIGN

05 Sep 2016

12 Sep 2016

19 Sep 2016
26 Sep 2016
03 Oct 2016

olols

10 Oct 2016
17 Oct 2016
24 Oct 2016
31 Cct 2016
07 Nov 2016
14 Nov 2016

FUNDING DETAILS

WVIEW CAMPAIGN IMPACT

21 Nov 2016

28 Nov 2016
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c. Stocklevel lines disappear

Part 6 : Troubleshooting

Stock entries are projected for one year after the last stock input. You have not updated the stock entries for one year. Please update the stock entries.

Edit data

@ [

Viva Country Region - PV~
Chart
Product Detail View > See details of the selected vaccine stock level and projections by week. s "
Please note that forecasts are approximate for the following month, and are not exact. SBY
1000 000
800 000
600 000
@
2
2
[«
o
« 400 DDO
200 000
0
w w w w w w w w w w w w w w w w w w w w w w w w w w w w w w w w w w w w w w w
S o & 4o o 8060680060606 06868668680680068000060000000000 0
8 8 "R 8 8 R 8 R R 8 A 8 8RR A8 AR \VIA /L I /LTI a8 a8 a8 8
2 = = = = = = = = ) = = o= o (=] [ =] [ =] = = = = =1 o o o o o [-% (-9 a a - - o o o 3 =3 =3
g 222223333 FFFgF=23333333 3733 32328888838 38882 28
5 s 83 F 28 yggegg 828 ES - -9 g 82488 e 248882535525
-8-STOCK LEVEL ‘:) « « STOCK LEVEL W/ FORECASTS ‘:) ==MIN STOCK LEVEL “:) FUNDING DETAILS
I CONFIRMED ORDER ‘:) FORECASTED ORDER l:) -~ MAX STOCK LEVEL ‘:) VIEW CAMPAIGN IMPACT
ICAMPAIGH “:)

28 Mov 2016
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d. There are no doses or minimum/maximum stock lines

Part 6 : Troubleshooting

ViVa has no data for your location and vaccine. You must go to Edit Data and enter in programmatic data to calculate the number of doses and
recommended min/max levels. You must also enter stock counts and any order information to generate data.

ViVa Country Region~

Product Detail View > See details of the selected vaccine stock level and projections by week

Chart

Edit data

@ 3

Not enough data to calculate current situation

- Export:
Please note that forecasts are approximate for the following month, and are not exact. D
@
&
20
"U
© e @ e e e W E oE oEoE e e e e e e E® e Y E P B B owowow e e e 8 ® @ ©® @ @
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-8-STOCK LEVEL ‘:) + + STOCK LEVEL W/ FORECASTS ‘:) == MIN STOCK LEVEL ‘:) FUNDING DETAILS
I CONFIRMED ORDER I) FORECASTED ORDER I) -~ MAX STOCK LEVEL I) VIEW CAMPAIGN IMPACT
ICAMPAIGN ‘:)
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7. Glossary

Actual/Projected stock level: Shows the actual stock level line using data from stock inputs from EPI managers. If no data is available, this line shows the
stock level using past entries and projections.

Campaign: Additional requirements linked to campaigns or outbreak responses. Can be included or excluded in the ViVa tool.

Confirmed delivery/order: Demand for a vaccine (based on annual forecasting exercise), for which UNICEF has a confirmed Purchase Order number.
Minimum level: The minimum stock level (safety) for each vaccine, under which stockouts can occur. Set to 12 weeks as default.

Maximum level: The maximum stock level (overstocking) for a vaccine, above which overstocking can occur. Set to 32 weeks as default.

Programmatic data: Data maintained by UNICEF, which contains vaccines and doses for the past years, covering both routine and campaigns, which is
uploaded to ViVa

Potential stock level: The estimated stock level projection if the forecasted orders materialized (i.e., converted to a confirmed order)

Supply Division (SD): UNICEF Supply Division, based in Copenhagen, Denmark, handles global vaccine procurement for UNICEF Country Offices and on
behalf of procurement services partners

Forecasted order: Demand for a vaccine (based on annual forecasting exercise), which has not been converted to a Purchase Order.
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